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1 What You Need To Know Before You Read This Document 

Before reading this document you should be familiar with the material in the TReK 

Getting Started User Guide (TREK-USER-001) and the TReK Telemetry Tutorial 

(TREK-USER-002).  If you have not read these documents, you may have difficulty with 

some of the terminology and concepts presented in this document. 

 

It is also recommended that you work through the Telemetry Trainer Tutorial (TREK-

USER-018) before reading this document.  The Telemetry Trainer Tutorial provides a 

step-by-step guide to the main features in the Telemetry Trainer application.  In contrast, 

this document provides details about each menu, dialog box, and message. 

 

We assume you are an experienced Windows user.  Information about how to use a 

mouse or how to use Windows is not addressed in this user guide.  Please see your 

Windows documentation for help with Windows. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK software 

applications, please try the following suggestions: 

 

Read the appropriate material in the manual and/or on-line help. 

 

Ensure that you are correctly following all instructions. 

 

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked 

Questions. 

 

If you are still unable to resolve your difficulty, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:  trek.help@nasa.gov 

Telephone:  256-544-3521 (8:00 a.m. - 4:30 p.m. Central Time) 

Fax:   256-544-9353 

 

TReK Help Desk hours are 8:00 a.m. – 4:30 p.m. Central Time Monday through Friday.  

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time. 
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3 Introduction 

The TReK Telemetry Trainer application provides the capability to generate data packets 

on your TReK system.  As discussed in the TReK Telemetry Tutorial (TREK-USER-

002), a TReK system can receive telemetry data from multiple sources.  The Telemetry 

Trainer application is used as a training tool to generate packets and send them to a 

designated TReK system for processing.   

 

Once you have decided to simulate a particular telemetry packet there are several things 

you can do with the packet.  You can choose to send, stop, pause, resume, or delete the 

packet.  You can also view and change the properties of a packet at any time.   

 

 

4 Telemetry Trainer Main Window 

The Telemetry Trainer main window consists of two main areas as shown in Figure 1.  

The top part of the main window contains the list of packets that your Telemetry Trainer 

is configured to send.  When you start the Telemetry Trainer application the list will be 

empty.  This is because you have not yet added any packets to the list.  The bottom part 

of the window is a message area that is used to display important status and error 

information messages about the Telemetry Trainer activities in progress. 

 

 
 

Figure 1 Telemetry Trainer Main Window 
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There are eight pieces of information that are displayed for each packet in the packet list.  

They are Packet ID, Packet Type, Data Mode, Source Address, Source Port, Destination 

Address, Destination Port, and Status.  The Packet ID, Packet Type, Data Mode, Source 

Address, and Destination Address uniquely identify the packet.  The Source Address, 

Source Port, Destination Address, and Destination Port identify the Transmission 

Information needed to send the packet.  The Status identifies the state of the packet 

stream (e.g., sending, stopped, paused, etc.).  This information will help you identify 

what packet stream you are sending. 

 

In Figure 1, the first packet in the list has a Packet ID of 7, which is a simulated PDSS 

Payload packet.  This packet shows Ready in the Status column, meaning that the packet 

has not been sent, but it is ready to be sent.  The second packet in the list is Packet ID 2.  

The Status column indicates that it is being sent, which means the Telemetry Trainer is 

currently sending this packet.  The third packet in the list is Packet ID 3, which is a PDSS 

Payload packet.  This packet has been stopped as indicated in the Status Column.  This 

packet can be sent again or deleted from the list.  The fourth packet in the list is Packet 

ID 6.  It is in a paused state and can be resumed, stopped, or deleted from the list.  All the 

packets in the packet list are controlled using the Packet menu.  There are also additional 

options on the File menu that provide a way to save a packet list configuration. 

 

If you are running the Telemetry Trainer application or viewing this document from 

within Microsoft Word then you have probably noticed that each packet row has a color 

associated with it.  The color provides information about the packet.  For example, when 

using the default colors, if the packet row is blue, this indicates that the packet is ready to 

send.  If the packet row is green, this indicates that data packets are being sent.  If the 

packet row is gold, this indicates that the generation of data packets has been paused or 

stopped.  The colors are helpful in providing immediate information about the general 

configuration and status of each packet in the list. 

 

 

 

 

5 Telemetry Trainer Menus 

The Telemetry Trainer application contains four main menus:  File, View, Packet, and 

Help.  Each of these menus are described in more detail below. 

 

5.1 File Menu 

The File menu is used to create, open, and save Telemetry Trainer configurations and to 

exit the Telemetry Trainer application.  A Telemetry Trainer configuration is comprised 

of the packets in the packet list along with all the information associated with each 

packet.  For example, suppose you have 3 packets in the packet list with different 

destination port numbers and IP Addresses.  If you save the configuration, all of this 

information will be saved in a file.  When you save a configuration, the Telemetry 

Trainer application will default to the 
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<base_path>\configuration_files\telemetry_trainer directory.  The <base_path> 

on a Windows 2000 computer is shown below. 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 

You can save your configuration files anywhere you like, but this default directory 

provides an easy way for you to keep up with your files.   

 

Each of the items on the File menu is described below.  

 

New 

New provides a way to start a new configuration.  When you start a new configuration 

any packets in the list are deleted and all activities associated with those packets are 

stopped.  If there are packets in the packet list when New is selected, you will be given 

the option of saving the configuration before all the packets are deleted from the packet 

list. 

 

Open 

Open provides a way to open a previously saved configuration. 

 

Save 

Save provides a way to save the current configuration. 

 

Save As 

Save As provides a way to save the current configuration with another name. 

 

Exit 

Exit provides a way to exit the Telemetry Trainer application. 

 

5.2 View Menu 

The View menu is used to change attributes associated with the Telemetry Trainer main 

window.  There are three items on the View menu.  Each is described below: 

 

Status Bar 

The Status bar is located at the very bottom of the Telemetry Trainer main window.  The 

status bar is used to display messages and useful information to you without interrupting 

your work  The status bar has "panes," which include "indicators" and a "message line."  

The indicators provide the status of items such as SCROLL LOCK. The message line on 

the status bar can display information about program status or about a toolbar button or 

menu item that you are pointing to with the mouse.  If you select the Status Bar item on 

the View menu, this will toggle the Status Bar on and off. 

 

Set Color Preferences 
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The Set Color Preferences option brings up the Set Color Preferences dialog.  This dialog 

can be used to turn off, turn on, or change the colors used in the Telemetry Trainer main 

window. 

 

Clear Message Area 

As mentioned in section 4, the Message Area is located at the bottom of the Telemetry 

Trainer main window.  This is where important status and error messages will be 

displayed while you are working with the application.  If you select the Clear Message 

Area item on the View menu, this will clear all the messages in the Message Area.  Once 

they have been cleared, you can not get them back. 

 

5.3 Packet Menu 

The Packet menu is the most frequently used menu in the Telemetry Trainer application.  

It is used to add packets to the packet list in the main window, and to control all the 

activities associated with each packet.  Each of the items on the Packet menu are 

described below. 

 

Add A Packet 

Used to identify a particular packet for the Telemetry Trainer to generate.  When you 

select Add A Packet, a dialog box will be presented so that you can fill in the information 

your Telemetry Trainer needs in order to send the packet (see section 6.2 for Add A 

Packet Dialog). 

 

Send Packet 

Used to tell the Telemetry Trainer to start sending the packet.  The Send Packet option is 

only available when you have a packet selected that is Ready or Stopped.  Some of the 

Packet menu options (such as Pause Packet, Stop Packet, etc.) will be unavailable until 

you Send the packet.  

 

Stop Packet 

Used to tell the Telemetry Trainer to stop sending a particular packet. The Stop Packet 

option is only available when you have a packet selected that is Sending or Paused. 

 

Pause Packet 

Used to tell the Telemetry Trainer to pause sending for a particular packet. The Pause 

Packet option is only available when you have a packet selected that is Sending. 

 

Resume Packet 

Used to tell the Telemetry Trainer to resume sending for a particular packet. The Resume 

Packet option is only available when you have a packet selected that is Paused. 

 

Delete Packet 

Used to tell the Telemetry Trainer to stop sending a particular packet and remove it from 

the list.  The Delete Packet option is only available when you have a packet selected. 
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Show Packet Properties 

Used to see a complete list of properties about a particular packet, such as the Packet ID, 

Database, and Packet Type.  It allows some of the properties to be changed (see section 

6.5 for details on the Packet Properties Dialog).  The packet properties are first set when 

you add the packet to the packet list using the Add A Packet dialog.  In fact, when you 

select Show Packet Properties the dialog box that appears is identical to the Add A 

Packet dialog.  The Show Packet Properties Option is only available when you have a 

packet selected. 

 

5.4 Help Menu 

The Help menu is used to access on-line help for the Telemetry Trainer application. Each 

of the items on the Help menu is described below. 

 

Help Topics 

Used to access the typical Windows Contents and Index on-line help window. 

 

About Telemetry Trainer 

Used to view the About Telemetry Trainer dialog. 

 

5.5 Packet List Pop-Up Menu 

The Packet List pop-up menu can be accessed by clicking the right mouse button in the 

packet list area of the main window.  If you right click in the packet list area of the 

window, but you do not click on a packet in the list, many of the menu items will be 

insensitive.  This is because these menu items are only applicable to a selected packet.  If 

you right click on a packet in the packet list all the menu items which are applicable to 

that particular packet at that moment in time will be sensitive.  The Packet List Pop-Up 

menu is identical to the Packet menu on the menu bar. 

 

5.6 Windows Edit Pop-Up Menu 

The standard Windows Edit Pop-Up Menu can be accessed whenever your cursor is 

located inside an edit field within the Telemetry Trainer application or within the 

message area on the Telemetry Trainer Main Window.  This menu contains the standard 

edit commands such as Cut, Copy, and Paste. 

 

 

6 Telemetry Trainer Dialog Boxes 

This section describes all the dialog boxes in the Telemetry Trainer application.  For an 

example of how some of these dialogs are used while working with the Telemetry Trainer 

application please see the Telemetry Trainer Tutorial (TREK-USER-018). 
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6.1 Set Color Preferences Dialog 

The Set Color Preferences dialog is shown in Figure 2 below.  It is used to control the 

color feature associated with the Telemetry Trainer main window packet list.  The color 

of a packet in the packet list indicates if the packet is in a ready, sending, paused, or 

stopped state.  The color feature can also be turned off.  If it is off the packets in the 

packet list will always be black.  If the color feature is on, the packets in the packet list 

will turn a specific color based on the packet status and the colors assigned in the Set 

Color Preferences dialog.   

 

 
 

Figure 2 Set Color Preferences Dialog 

 

 

Each field and control on the Set Color Preferences dialog is described below. 

 

Color On 

Turns the color feature on. 

 

Color Off 

Turns the color feature off. 

 

Ready Color 

The color assigned when the status of the packet is “Ready”.  “Ready” indicates that the 

packet is ready to be sent.  This will be the current state right after the packet has been 

added to the packet list. 

 

Sending Color 
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The color assigned when the status of the packet is “Sending”.  This status will occur 

when the packet is being transmitted. 

 

 

 

 

Stopped Data Color 

The color assigned when the status of the packet is “Stopped”.  This status will occur 

when Telemetry Trainer has sent all of the packets requested or when the packet has been 

stopped or paused from the Packet Menu.  

 

Status Unknown Color 

The color assigned when the status of the packet is unknown.  This will occur if the 

packet has been sent, but an error occurred while trying to determine the status of the 

packet. 

 

 

Buttons 

 

Select Color 

The Select Color button is used to access the standard Windows Color dialog in order to 

change the assigned color. 

 

Set to Defaults 

The Set to Defaults button will reset all the fields and controls in the Set Preferences 

dialog box to the original values that were in place when the TReK software was 

installed. 

 

 

6.2 Add A Packet Dialog 

The Add A Packet dialog is used to add a packet to the packet list in the main window.  

Remember that this is how you add packets to the Telemetry Trainer to be sent to your 

TReK system for simulation purposes.  Packets are uniquely identified by a combination 

of Packet ID, Packet Type, Data Mode, and Destination IP Address.  As can be seen in 

Figure 3, the Add A Packet dialog is divided into two sections:  Packet Information and 

Transmission Information.  The Packet Information section contains information that tells 

your Telemetry Trainer what packet to generate.  The Transmission Information section 

tells your Telemetry Trainer how to transmit the packet.   
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Figure 3 Add A Packet Dialog Box 

 

 

Each field on the Add A Packet dialog is described below. 

 

Database (Required Field) 

The database field is used to tell your TReK system which database to use when 

processing (decommutating, calibrating, sensing, etc.) your packet and the parameters 

inside the packet.   The database field must contain the complete directory path and name 

for your database.  An example of this is 

c:\TReK\database\TelemetryDatabase.mdb.  If you don’t know the complete path, 

you can push the Browse… button located to the right of the Database field.  This will 

bring up a Windows Open dialog box that you can use to search local directories to find 

your database file.  The Open dialog is not described in this document since it is a typical 

Windows dialog box.  If you need help with this dialog, please refer to the Windows on-

line help.  The Open dialog will default to the <base_path>\database directory.  The 

<base_path> on a Windows 2000 computer is shown below. 

 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 



TREK-USER-004 

 10 

You can save your database files anywhere you like, but this default directory provides 

an easy way for you to keep up with your database files.   

 

Packet ID (APID) (Required Field) 

The Packet ID is one of the primary packet attributes that is used by your Telemetry 

Trainer to identify a packet.  The term Packet ID is synonymous with the term 

Application Process ID (APID).  As described in the TReK Telemetry Tutorial (TREK-

USER-002), the Packet ID (or APID) is located in the primary header of a Consultative 

Committee for Space Data Systems (CCSDS) packet.  When a packet arrives at your 

TReK system, this header is checked to determine whether the packet should be accepted 

or dropped.  If you don’t have the Packet ID memorized, you can Browse the database to 

find the Packet ID.  This can be done by pushing the Browse Database button located to 

the right of the Packet ID field.  The Browse Database dialog is described in section 6.3.   

 

Packet Type  (Required Field) 

The Packet Type field is used to tell the Telemetry Trainer something about the simulated 

source of the packet and the packet type.  There are a fixed set of packet types that will be 

simulated: CCSDS, CDP, EXPRESS, FDP, GSE, GSE Merge, IMAQ ASCII, PDSS 

Core, PDSS Payload, PDSS RPSM, PDSS UDSM, PRCU, Suitcase Simulator, UFO, 

VCDU.  Please note that when the Telemetry Trainer application generates PDSS 

Payload packets it will also generate the corresponding PDSS User Data Summary 

Message (UDSM) packets.  See section 7.1 for more information about the Telemetry 

Trainer and PDSS UDSM packets. 

 

Data Mode (Required Field) 

The Data Mode field is used to tell the Telemetry Trainer what type of data mode is 

associated with your packet.  There are a fixed set of sixteen data modes which are 

supported by the Telemetry Trainer and your TReK system.  They are:  None, RealTime, 

Dump1, Dump2, Dump3, Playback1, Playback2, Playback3, Playback4, Playback5, 

Playback6, Playback7, Playback8, Playback9, Playback10, and Playback11. The None 

data mode is only used with Suitcase Simulator packets.  It should never be used for 

PDSS Payload or GSE packets.  If you select a playback data mode, this indicates that 

you will be simulating an external playback. 

 

Source IP Address   (Required Field) 

The Source IP address field is used to tell your Telemetry Trainer the IP address of the 

network card your TReK system will send data from.  The Source IP Address field 

defaults automatically to the first network card IP address located in the Windows 

registry.  Your TReK system retrieves your local unicast IP address from the Windows 

registry.  If you are not familiar with the registry don’t worry about it.  You don’t need to 

be familiar with the registry to use the Telemetry Trainer application.  If you want to see 

a list of all the IP addresses for your machine, just push the Browse button next to the 

Source IP address field.  The Browse For IP Address dialog is described in section 6.4. 

 

If your TReK system does not have network connectivity (such as no ethernet card or 

modem or the system is not connected to a network), the default will be set to 127.0.0.1.  
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This is called a loopback address and can be used while you are working in standalone 

mode. 

 

Source Port Number  (Required Field) 

The Source Port Number is used to tell your Telemetry Trainer which port to send the 

packet from. 

 

Destination IP Address   (Required Field) 

The Destination IP address field is used to tell your Telemetry Trainer the destination of 

the TReK system you wish to send the packet to.  It’s kind of like your home address on a 

letter that is arriving via a postal service.  The Telemetry Trainer acts as the person who 

is sending the letter and puts your address on it so the post office knows where to deliver 

the letter.  The Telemetry Trainer uses the Destination IP address (and port number) to 

tell the networks along the way how to get the packets to the TReK system you are 

sending to.  In most cases you will probably enter your local TReK system’s unicast IP 

Address.   The Destination IP Address field defaults automatically to your local unicast 

IP address.  Your Telemetry Trainer retrieves this information from the Windows 

registry.  If you are not familiar with the registry, don’t worry about it.  You don’t need to 

be familiar with the registry to use the Telemetry Trainer application.   

 

If your TReK system does not have network connectivity (such as no ethernet card or 

modem or the system is not connected to a network), the default will be set to 127.0.0.1.  

This is called a loopback address and can be used while you are working in standalone 

mode. 

 

Destination Port Number  (Required Field) 

The Destination Port Number is used to tell your Telemetry Trainer which port to send 

the packet to on your TReK system.  The Destination Port Number is very similar to the 

Destination IP address in that it identifies specific information about where the packet 

will be sent.  The destination port number and the source port should be different if 

sending to the same PC.  Duplicate destination and source ports can be used if the 

destination is not the local PC. 

 

You will define the Destination Port Number that should be used when the packet is 

generated.  Therefore, make sure you identify the same Port Number on the receiving 

side in the Telemetry Processing application.  Otherwise, the packet won’t be accepted by 

your TReK system even though your TReK system is generating it. 

 

Transmission Protocol 

The Transmission Protocol is for sending a packet can be either UDP or TCP. 

 

Transmission Rate 

The Transmission Rate is used to tell your TReK system the rate at which to transmit 

your data.  You can enter the transmission rate in packets per second or bits per second.    

For example, you may want to send 10 packets per second.  If the Run Time is set to 10 

seconds, then you would have sent approximately 100 packets during that runtime.  Note, 
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the operating system’s timing precision is limited to 1/100th of a second.  Therefore, to 

achieve packet rates greater than 100 packets per second, the Telemetry Trainer must 

transmit packets in groups.  This “bursting” implementation can create discrepancies 

between the number of packets that were expected to be sent and the actual number of 

packets that were sent. 

 

Run Time 

The Run Time is used to tell the Telemetry Trainer how many seconds the packet should 

be sent.  For instance, you may want the Run Time to be 100 seconds.  If the number of 

packets you were sending was 1 per second, then you would have sent 100 packets during 

the specified runtime.  

 

6.3 Browse Database Dialog 

The Browse Database dialog is shown in Figure 4.  This dialog is used to search a TReK 

database for a Packet ID.  

 

 

Figure 4 Browse Database Dialog 

 

Each field in the Browse Database dialog is described below. 

 

Database (Required Field) 

The database field is used to tell your TReK system which database to search.   The 

database field must contain the complete directory path and name for the database.  An 

example of this is c:\TReK\database\TelemetryDatabase.mdb.  If you don’t know 

the complete path, you can push the … (dot dot dot) button located to the right of the 

Database field.  This will bring up a Windows Open dialog box which you can use to 

search local directories to find your database file.  The Open dialog will default to the 
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<base_path>\database directory.  The <base_path> on a Windows 2000 computer is 

shown below. 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 

Packet ID Filter  (Optional Field) 

If you do not fill in the Packet ID Filter field, the search will return all packet IDs in the 

database.  You can use a * wildcard to represent zero or more characters when specifying 

the filter or a ? to represent any single character.  For example, the following filters are 

valid:  12*, 1*3, *12, 1??.  The 12* filter indicates that all Packet IDs that begin with 12 

should be returned.  The 1*3 filter indicates that all Packet IDs that begin with 1 and end 

with 3 and have any number of characters in between should be returned.  The *12 filter 

indicates that all Packet IDs that end in 12 should be returned.  The 1?? filter indicates 

that all Packet IDs that begin with 1 followed by exactly two more characters should be 

returned. 

 

Packet ID List 

This list shows all the Packet IDs returned as a result of the search.  There are two 

columns of information.  The column on the left shows the Packet ID and the column on 

the right shows the packet type.  You can sort the list based on either Packet ID or Packet 

Type.  To sort the list by Packet ID, use your mouse to left click on the column header 

labeled Packet ID.  To sort the list by Packet Type, use your mouse to left click on the 

column header labeled Packet Type.  When you click on a column header you will see an 

up arrow or a down arrow.  The arrow indicates whether the sort is ascending or 

descending. 

 

Packet ID 

The Packet ID field is filled in when you select a Packet ID in the list.  The Packet ID 

will be copied to the dialog box that contained the button you used to bring up the 

Browse Database dialog. 

 

 

Dialog Buttons 

There is one non-standard button on the Browse Database dialog box.  It is described 

below. 

 

Search 

The Search button executes the database search based on the criteria you have entered in 

the Database and Packet ID Filter fields. 

 

6.4 Browse For IP Address Dialog 

The Browse For IP Address dialog is shown in Figure 5.  This dialog is used to search a 

TReK system for all IP addresses or network cards associated with the system.  
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Figure 5 Browse For IP Address Dialog 

 

 

Each field in the Browse For IP Address dialog is described below. 

 

Please select an IP Address: (Required Field) 

You have two options when choosing an IP address.  If your TReK system does not have 

network connectivity (such as no ethernet card or modem or the system is not connected 

to a network), you need to use the standard loopback address (127.0.0.1).  This option is 

provided by choosing the “Loopback Address: 127.0.0.1” radio button.  Users with one or 

more network cards will need to choose which network card or IP Address they would 

like to use.  Choosing the “IP Address List” radio button provides this option.  The user 

must then select an IP address from the list. 

 

IP Address 

The IP Address field is filled in when you select the Loopback IP address or an IP 

Address in the list.  The IP Address will be copied to the dialog box that contained the 

button you used to bring up the Browse For IP Address dialog. 

 

6.5 Packet Properties Dialog 

When you select Show Packet Properties for a packet a dialog that is identical (except for 

the title) to the Add A Packet dialog (see section 6.2) will be displayed.  This is the 

Packet Properties dialog and it will be populated with all the properties you selected 

when you added the packet.  All properties are read-only on this dialog after you have 

added the packet, except Destination IP Address, Destination Port Number, Runtime and 

Number of Packets.  You cannot change any of the read only fields in this dialog.  If you 

need to change these read only packet properties, you need to delete the packet from the 

packet list in the main window and add a new packet.  You can, however, change the 

Destination IP Address, Destination Port Number, Runtime, or Number of Packets fields.  
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If any of these four properties have been updated the packet will be stopped and updated 

with the new properties.  The Packet Properties dialog box can be accessed using the 

Packet Menu’s Show Packet Properties option, by using the Packet List pop-up menu, or 

by double clicking on the packet in the main window packet list.  You must have a packet 

selected in order to access this dialog. 

 

 

6.6 Invalid Configuration Information Dialog 

The Invalid Configuration Information dialog is shown in Figure 6.  This dialog only 

appears if you attempt to open a configuration file that contains invalid configuration 

information.  This usually happens when you move a configuration file from one machine 

to another.  For example, when you save a configuration file, the packets and all the 

information associated with the packets (including the IP address information and the 

location of the database file) are stored in the configuration file.  If you move the 

configuration file, then some of this information will no longer be valid. 

 

The Invalid Configuration Information dialog contains two lists.  The list at the top of the 

dialog contains a list of the packets that are stored in the configuration file.  If the packet 

contains any invalid information it will be red.  When you select a packet in the packet 

list, the list located below the packet list will display all the invalid items associated with 

that particular packet.   
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Figure 6 Invalid Configuration Information Dialog Box 

 

 

Buttons 

 

Modify 

When you select a packet in the packet list and push the Modify button, the Packet 

Properties dialog will be displayed.  The Packet Properties dialog can be used to change 

the properties that are invalid. 

 

Cancel 

Selecting the Cancel button will abort the entire process and leave the configuration file 

unchanged. 

 

 

6.7 Delete Packet Warning Message Dialog 

The Delete Packet Warning Message Dialog will appear if you attempt to delete an active 

packet from the packet list in the main window.  If you are sure you want to proceed 

answer Yes.  If you do not want to proceed answer No and no action will be taken. 

 

 
 

Figure 7 Delete Packet Warning Message Dialog Box 
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6.8 Close Configuration Warning Message Dialog 

The Close Configuration Warning message dialog will appear if you attempt to perform a 

New or Open and there are packets in the packet list.  If you are sure you want to proceed 

answer Yes.  If you do not want to proceed answer No and no action will be taken. 

 

 
 

Figure 8 Close Configuration Warning Message Dialog Box 

 

 

6.9 Save Changes Message Dialog 

If you select New, Open, or Exit, and the current configuration has not been saved, the 

Save Changes message dialog will be displayed.  If you are exiting the application, the 

application will Exit after you respond to the Save Changes dialog. 

 

 

Figure 9 Save Changes Message Dialog Box 

 

 

6.10 Exit Confirmation Message Dialog 

The Exit Confirmation message dialog is displayed to help you avoid exiting the 

Telemetry Trainer application by accident.  It will only be displayed if you exit the 

application with the current configuration unchanged.  If the configuration has changed 

you will be prompted with the Save Changes dialog instead of the Exit Confirmation 

dialog.  If you are prompted with the Exit Confirmation dialog and you are sure you want 

to exit answer Yes.  If you do not want to exit the application, answer No, and the 

application will not proceed with the exit. 
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Figure 10 Exit Confirmation Message Box 

 

 

7 Special Topics 

This section addresses a few of the special topics associated with the Telemetry Trainer 

application. 

 

 

7.1 Does Telemetry Trainer simulate PDSS UDSM packets? 

In the POIC when a scheduled Loss of Signal (LOS) occurs, PDSS will generate a User 

Data Summary Message (UDSM) for any packet that is no longer arriving.  The UDSM 

packet contains information on the number of packets transmitted, the start and stop time, 

and various errors.  Please see the POIC to Generic User Interface Definition Document 

(SSP-50305) for more information about PDSS UDSM packets.  The TReK Telemetry 

Trainer simulates this scheduled LOS UDSM packet.  When the Telemetry Trainer 

completes transmission of a PDSS Payload packet a PDSS UDSM packet is generated 

and sent to the same destination IP address and port number.  This packet contains the 

start and stop times and the number of packets transmitted.  There are no errors generated 

in this packet.  The UDSM packet is not generated when the user initiates a Pause or Stop 

from the packet menu. 

 

 

7.2 Can I use the Telemetry Trainer application as a testing tool? 

It is not advisable to use the Telemetry Trainer application as a testing tool to test your 

network or the performance of a TReK system.  This is because the Telemetry Trainer 

was designed as a training tool only and not as a generic data packet generator tool to be 

used for testing purposes.   

 

The Windows operating system’s timing precision is limited to 1/100th of a second.  

Therefore, to achieve packet rates greater than 100 packets per second, the Telemetry 

Trainer must transmit packets in groups.  This “bursting” implementation can create 

discrepancies between the number of packets that were expected to be sent and the actual 

number of packets that were sent.  This is one of the main reasons that it is not advisable 

to use the Telemetry Trainer application as a test tool but instead as a training tool as it 

was intended. 
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The purpose of the Telemetry Trainer application is to provide a way for you to learn 

how to use your TReK system by providing a local data source that has no external 

dependencies. 

 

 

8 Messages 

Error messages are listed in the Telemetry Trainer On-Line Help. 
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Appendix A Glossary 
Note:  This Glossary is global to all TReK documentation.  All entries listed may not be 

referenced within this document. 

 

Application Programming Interface 

(API) 

A set of functions used by an application program 

to provide access to a system’s capabilities. 

 

Application Process Identifier 

(APID) 

An 11-bit field in the CCSDS primary packet 

header that identifies the source-destination pair 

for ISS packets. The type bit in the primary header 

tells you whether the APID is a payload or system 

source-destination. 

 

Calibration The transformation of a parameter to a desired 

physical unit or text state code. 

 

Communications Outage Recorder System that captures and stores payload science, 

health and status, and ancillary data during TDRSS 

zone of exclusion. 

 

Consultative Committee for Space  

Data Systems (CCSDS) format 

Data formatted in accordance with 

recommendations or standards of the CCSDS. 

 

Consultative Committee for Space  

Data Systems (CCSDS) packet 

A source packet comprised of a 6-octet CCSDS 

defined primary header followed by an optional 

secondary header and source data, which together 

may not exceed 65535 octets. 

 

Conversion Transformation of downlinked spacecraft data 

types to ground system platform data types. 

 

Custom Data Packet A packet containing a subset of parameters that 

can be selected by the user at the time of request. 

 

Cyclic Display Update Mode A continuous update of parameters for a particular 

display. 

 

Decommutation (Decom) Extraction of a parameter from telemetry. 

 

Discrete Values Telemetry values that have states (e.g., on or off). 
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Dump During periods when communications with the 

spacecraft are unavailable, data is recorded 

onboard and played back during the next period 

when communications resume.  This data, as it is 

being recorded onboard, is encoded with an 

onboard embedded time and is referred to as dump 

data. 

 

Enhanced HOSC System (EHS) Upgraded support capabilities of the HOSC 

systems to provide multi-functional support for 

multiple projects. It incorporates all systems 

required to perform data acquisition and 

distribution, telemetry processing, command 

services, database services, mission support 

services, and system monitor and control services. 

 

Exception Monitoring A background process capable of continuously 

monitoring selected parameters for Limit or 

Expected State violations. Violation notification is 

provided through a text message. 

 

Expected State Sensing Process of detecting a text state code generator in 

an off-nominal state. 

 

EXPRESS An EXPRESS Rack is a standardized payload rack 

system that transports, stores and supports 

experiments aboard the International Space 

Station. EXPRESS stands for EXpedite the 

PRocessing of Experiments to the Space Station. 

 

File transfer protocol (ftp) Protocol to deliver file-structured information from 

one host to another. 

 

Flight ancillary data A set of selected core system data and payload 

health and status data collected by the USOS 

Payload MDM, used by experimenters to interpret 

payload experiment results. 
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Grayed out Refers to a menu item that has been made 

insensitive, which is visually shown by making the 

menu text gray rather than black.  Items that are 

grayed out are not currently available. 

 

Greenwich Mean Time (GMT) The solar time for the meridian passing through 

Greenwich, England.  It is used as a basis for 

calculating time throughout most of the world. 

 

Ground ancillary data A set of selected core system data and payload 

health and status data collected by the POIC, 

which is used by experimenters to interpret 

payload experiment results.  Ground Ancillary 

Data can also contain computed parameters 

(pseudos). 

 

Ground receipt time Time of packet origination. The time from the 

IRIG-B time signal received. 

 

Ground Support Equipment (GSE) GSE refers to equipment that is brought in by the 

user (i.e. equipment that is not provided by the 

POIC). 

 

Ground Support Equipment Packet A CCSDS Packet that contains data extracted from 

any of the data processed by the Supporting 

Facility and the format of the packet is defined in 

the Supporting Facility’s telemetry database. 

 

Huntsville Operations Support 

Center (HOSC) 

A facility located at the Marshall Space Flight 

Center (MSFC) that provides scientists and 

engineers the tools necessary for monitoring, 

commanding, and controlling various elements of 

space vehicle, payload, and science experiments. 

Support consists of real-time operations planning 

and analysis, inter- and intra-center ground 

operations coordination, facility and data system 

resource planning and scheduling, data systems 

monitor and control operations, and data flow 

coordination. 
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IMAQ ASCII A packet type that was added to TReK to support a 

very specific application related to NASA’s Return 

to Flight activities.  It is not applicable to ISS.  It is 

used to interface with an infrared camera that 

communicates via ASCII data. 

 

Limit Sensing Process of detecting caution and warning 

conditions for a parameter with a numerical value. 

 

Line Outage Recorder Playback A capability provided by White Sands Complex 

(WSC) to play back tapes generated at WSC 

during ground system communication outages. 

 

Measurement Stimulus Identifier 

(MSID) 

Equivalent to a parameter. 

 

 

Monitoring A parameter value is checked for sensing 

violations. A message is generated if the value is 

out of limits or out of an expected state. 

Parameter TReK uses the generic term parameter to mean any 

piece of data within a packet.  Sometimes called a 

measurement or MSID in POIC terminology. 

 

Payload Data Library (PDL) An application that provides the interface for the 

user to specify which capabilities and requirements 

are needed to command and control his payload. 

 

Payload Data Services Systems 

(PDSS) 

The data distribution system for ISS.  Able to route 

data based upon user to any of a number of 

destinations. 

 

Payload Health and Status Data Information originating at a payload that reveals 

the payload’s operational condition, resource 

usage, and its safety/anomaly conditions that could 

result in damage to the payload, its environment or 

the crew. 

 

Payload Operations Integration 

Center (POIC) 

Manages the execution of on-orbit ISS payloads 

and payload support systems in 

coordination/unison with distributed International 

Partner Payload Control Centers, Telescience 

Support Centers (TSC’s) and payload-unique 

remote facilities. 

 



TREK-USER-004 

 24 

 

Payload Rack Checkout Unit 

(PRCU) 

The Payload Rack Checkout Unit is used to verify 

payload to International Space Station interfaces 

for U.S. Payloads. 

 

Playback Data retrieved from some recording medium and 

transmitted to one or more users. 

 

Pseudo Telemetry (pseudo data) Values that are created from calculations instead of 

directly transported telemetry data.  This pseudo 

data can be created from computations or scripts 

and can be displayed on the local PC. 

 

Remotely Generated Command A command sent by a remote user whose content 

is in a raw bit pattern format.  The commands 

differ from predefined or modifiable commands in 

that the content is not stored in the POIC Project 

Command Database (PCDB). 

 

Science data Sensor or computational data generated by 

payloads for the purpose of conducting scientific 

experiments. 

 

Subset A collection of parameters from the total 

parameter set that is bounded as an integer number 

of octets but does not constitute the packet itself.  

A mini-packet. 

 

Super sampled A parameter is super sampled if it occurs more 

than once in a packet. 

 

Swap Type A flag in the Parameter Table of the TReK 

database that indicates if the specified datatype is 

byte swapped (B), word swapped (W), byte and 

word swapped (X), byte reversal (R), word 

reversal (V) or has no swapping (N). 

 

Switching A parameter’s value can be used to switch between 

different calibration and sensing sets.  There are 

two types of switching on TReK:  range and state 

code. 
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Transmission Control Protocol 

(TCP) 

TCP is a connection-oriented protocol that 

guarantees delivery of data. 

 

Transmission Control Protocol 

(TCP) Client 

A TCP Client initiates the TCP connection to 

connect to the other party. 

 

Transmission Control Protocol 

(TCP) Server 

A TCP Server waits for (and accepts connections 

from) the other party. 

 

Telemetry Transmission of data collected form a source in 

space to a ground support facility. Telemetry is 

downlink only. 

 

Telescience Support Center (TSC) A TSC is a NASA funded facility that provides the 

capability to plan and operate on-orbit facility 

class payloads and experiments, other payloads 

and experiments, and instruments. 

 

User Application Any end-user developed software program that 

uses the TReK Application Programming Interface 

software.  Used synonymously with User Product. 

 

User Data Summary Message 

(UDSM) 

Packet type sent by PDSS that contains 

information on the number of packets sent during a 

given time frame for a PDSS Payload packet.  For 

details on UDSM packets, see the POIC to Generic 

User IDD (SSP-50305). 

 

Uplink format The bit pattern of the command or file uplinked. 

 

User Datagram Protocol (UDP) UDP is a connection-less oriented protocol that 

does not guarantee delivery of data.  In the TCP/IP 

protocol suite, the UDP provides the primary 

mechanism that application programs use to send 

datagrams to other application programs.  In 

addition to the data sent, each UDP message 

contains both a destination port number and a fully 

qualified source and destination addresses making 

it possible for the UDP software on the destination 

to deliver the message to the correct recipient 

process and for the recipient process to send a 

reply. 
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User Product Any end-user developed software program that 

uses the TReK Application Programming Interface 

software. Used synonymously with User 

Application. 

 

Web Term used to indicate access via HTTP protocol; 

also referred to as the World Wide Web (WWW). 
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Appendix B Acronyms 
Note:  This acronym list is global to all TReK documentation.  Some acronyms listed 

may not be referenced within this document. 

 

AOS   Acquisition of Signal 

API   Application Programming Interface 

APID   Application Process Identifier 

ASCII   American Standard Code for Information Interchange 

CAR   Command Acceptance Response 

CAR1   First Command Acceptance Response 

CAR2   Second Command Acceptance Response 

CCSDS  Consultative Committee for Space Data Systems 

CDB   Command Database 

CDP   Custom Data Packet 

COR   Communication Outage Recorder 

COTS   Commercial-off-the-shelf 

CRR   Command Reaction Response 

DSM   Data Storage Manager 

EHS   Enhanced Huntsville Operations Support Center (HOSC) 

ERIS   EHS Remote Interface System 

ERR   EHS Receipt Response 

EXPRESS  Expediting the Process of Experiments to the Space Station 

ES   Expected State 

FAQ   Frequently Asked Question 

FDP   Functionally Distributed Processor 

FSV   Flight System Verifier 

FSV1   First Flight System Verifier 

FSV2   Second Flight System Verifier 

FPD   Flight Projects Directorate 

FTP   File Transfer Protocol 

GMT   Greenwich Mean Time 

GRT   Ground Receipt Time 

GSE   Ground Support Equipment 

HOSC   Huntsville Operations Support Center 

ICD   Interface Control Document 

IMAQ ASCII  Image Acquisition ASCII 

IP   Internet Protocol 

ISS   International Space Station 

LDP   Logical Data Path 

LES   Limit/Expected State 

LOR   Line Outage Recorder 

LOS   Loss of Signal 

MCC-H  Mission Control Center – Houston  

MOP   Mission, Operational Support Mode, and Project 

MSFC   Marshall Space Flight Center 
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MSID   Measurement Stimulus Identifier 

NASA   National Aeronautics and Space Administration 

OCDB   Operational Command Database 

OS   Operating System 

PC   Personal Computer, also Polynomial Coefficient 

PCDB   POIC Project Command Database 

PDL   Payload Data Library 

PDSS   Payload Data Services System 

PGUIDD  POIC to Generic User Interface Definition Document 

POIC   Payload Operations Integration Center 

PP   Point Pair 

PRCU   Payload Rack Checkout Unit 

PSIV   Payload Software Integration and Verification 

RPSM   Retrieval Processing Summary Message 

SC   State Code 

SCS   Suitcase Simulator 

SSP   Space Station Program 

SSCC   Space Station Control Center 

SSPF   Space Station Processing Facility 

TCP   Transmission Control Protocol 

TReK   Telescience Resource Kit 

TRR   TReK Receipt Response 

TSC   Telescience Support Center 

UDP   User Datagram Protocol 

UDSM   User Data Summary Message 

URL   Uniform Resource Locator 

USOS   United States On-Orbit Segment 

VCDU   Virtual Channel Data Unit 

VCR   Video Cassette Recorder 

VPN   Virtual Private Network 
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Appendix C Trainer File Format 
Generator Files 

This short write up is to help users to build the text files needed to simulate packets.  The 

example used will be based on PDSS Payload packets.  However, you can “fake” other 

types of packets by changing these text files to actually generate something else (e.g., 

GSE Packets). 

 

Where To Start 

The easiest way to build a new packet is to start with a copy of a file that already works.  

The files shipped in the gen_files directory in the TReK installation are good starting 

points.  These files already contain the EHS and CCSDS header information.  You will 

just need to change a few values such as the APID and packet lengths. 

 

When you make a copy of the file, rename it to apid_<NUMBER>.pkt.  The NUMBER 

is the APID value in the CCSDS primary header.  Even if the packet generates something 

else, the Training Simulator application will determine if it can generate a file based on 

the number in the filename. 

 

File Format 

There are two main sections in the generator file.  The first section is the values section.  

It contains the detailed information about how to generate the different values that will be 

placed in the packet.  This section is delimited by the #value and #end_value keywords.  

The second section is the packet layout section.  This section has the details of how the 

values are placed in the packet.  This section is delimited by the #packet and #end_packet 

keywords. 

 

Values 

An example of the data in this section is shown below: 

 

EXS_TLM_DATA_TYPE IUND 16 1 4 

1    |  

0001        | 

1  one cycle      | 

0002  one sample      |--  four sets 

1        | 

0003        | 

1        | 

0004    | 

 

The first line contains the parameter name, data type, length (in bits), the number of 

samples per packet, and the number of sets of data.  The parameter name will correspond 

to the parameter name in the packet layout section of the file.  The data type is limited to 

the following:  SASC, SASCB, SEBC, SUND, IDIS, IMAG, IUND, IUNS, ITWO, 

ITWOW, FEEE, TEHS, and TISS.  The length of the parameter is always in bits.  The 

number of samples is the maximum number of samples that can appear in a packet.  The 
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number of sets of data allows you to have multiple sets of data generation information.  

The example above has four sets. 

 

After the first line you will have each set of data.  For each set of data, the first line is the 

number of cycles that the data set is active.  In the example above each of the four sets is 

active for one cycle (packet).  The next line will vary based on the data type used.  In the 

example above the data type is IUND so the data is input in hex.  The following table 

shows the data types and the expected input types from the file. 

 

Data Type Input Data As 

SASC ASCII Text 

SASCB ASCII Text 

SEBC ASCII Text 

SUND Hexadecimal 

IDIS Hexadecimal 

IMAG Value 

ITWO Value 

ITWOW Value 

IUND Hexadecimal 

IUNS Value 

FEEE Value 

TEHS Do not add a line, will use system time 

TISS Do not add a line, will use system time minus 30 minutes 

 

The following is an example of a parameter that takes ASCII text as the input. 

 

GENERIC_MESSAGE  SASC 2048 1 1 

1 

Now is the time for all good men to go to lunch. 

 

And now an example of a parameter that takes a value as input. 

 

M_CP_SC_14  IUNS 14 1 1 

1 

0 1 0 16383 

 

The final line for the value consists of the start value (0), the increment value (1), the 

minimum value (0), and the maximum value (16383).  These values can be integers or 

floating-point numbers.  If the value reaches the maximum value, it will go back to the 

minimum value and continue changing.  If the value reaches the minimum value, it will 

go back to the maximum value and continue changing.  For the example above the 

sequence is… 

 

1st packet – 0 

2nd packet –1 
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3rd packet – 2 

… 

16383rd packet - 16382 

16384th packet - 16383 

16385th packet – 0 

 

If you want to simulate a data type that is not supported by the Training Simulator, it is 

probably best to use an IUND data type.  Set the length to the value of the data type to 

simulate and place the hexadecimal pattern in the values section.  You can take advantage 

of the multiple sets option to generate several values. 

 

Packet Layout 

The packet layout section is a little more complex than the value section.  The packet 

consists of parameters and containers (subsets).  The containers consist of parameters and 

other containers.  The first line after the #packet keyword will contain two fields as 

shown below 

 

#packet 

APID_889 40000 

 

The first is just the name.  It can be any string.  The second value is the length of the 

packet in bits. 

 

Below is an example for a parameter to be placed in the packet. 

 

CORR_COEF_AUTOCORR  0 32 N S 

10 32 1 0 

 

Each parameter will have 2 or 3 lines to define its position in a packet.  Using the 

example above the first line contains five fields:  parameter name 

(CORR_COEF_AUTOCORR), start bit (0), length in bits (32), dependency (N), and 

parent type (S).  The parameter name is the same name as the parameter name from the 

value section.  The start bit is the start location of the first bit with respect to its parent 

container (packet or subset).  The length is the size in bits of a single instance of the 

parameter.  The dependency lets you know if something appears in every packet (N), is 

dependent on a counter (C), or is dependent on a range (R).  The final field in the first 

line lets you know what the parent type is (in this case S means subset).  Don’t worry too 

much about this field.  You should not have to change it unless you make major changes 

to your packet layout.  The best way to make these updates is to start from another packet 

definition.  Just keep the same parent type as before. 

 

The second line of the packet layout contains four fields:  The number in group (10), the 

group offset (32), the number in super group (1), and the super group offset (0).  If the 

value for the number in group is 1, then the group offset is ignored.  The same is true for 

number in super group and super group offset.  The example above is equivalent to the 

MSFC-STD-1274 Bit Contiguous Group.  Remember that TReK can process more than 
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what is defined in MSFC-STD-1274.  If you only have one sample of a parameter the 

second line will always be 

 

1 0 1 0 

 

The third line of the packet layout (which doesn’t exist in this example) defines the 

counter or range parameters (the C or R options for dependencies).  If the value of the 

dependency is C or R, the third line is as follows: 

 

DEP_PARAM  0 3 

 

If this was for a counter dependent parameter (C), the first item is the parameter whose 

value is check for the dependency.  The second item is the start counter and the third item 

is the counter offset.  The parameter would appear when the counter was 0, 3, 6, etc.  If 

this was for a range dependent parameter (R), the first item is the parameter whose value 

is checked for the dependency.  The second item is the low range and the third item is the 

high range.  For range parameters the second and third values can be floating point 

numbers. 

 

Containers 

Containers are like subsets.  They are delimited by the #fixed_container and 

#end_fixed_container keywords.  There is no preset limit to nesting of containers.  No, 

there are not random containers (subsets) in this version.  Below is a very simple example 

of a container. 

 

#fixed_container 

SUBSET_ONE  976 48 C U 

SOME_COUNTER  0 2 

Measurement_Zero  0 16 N F 

3 16 1 0 

#end_fixed_container 

 

There is one required and one optional line for each container.  The first line (required) 

contains the container name (SUBSET_ONE), the start bit (976), the length in bits (48), 

the dependency (C) and that parent type (U).  Remember that the start bit is relative to the 

parent of the container.  The second line (optional) is only present if the dependency type 

is C or R.  In this case, the container (subset) is counter dependent and is available when 

the SOME_COUNTER value is even. 

 

This container has a single parameter that is sampled three times in a group. 

 

Single Characters and What They Mean 

A little explanation of each type is appropriate now.  For the dependency there are three 

possible values: 

 

N No dependency 
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C Counter dependent 

R Range dependent 

 

It is a little more complex for the parent type… 

 

H Header MSID, used only for items in the EHS Primary and Secondary Headers. 

U User Data, includes CCSDS headers and data zone. 

F Fixed Container, measurement data in a #fixed_container 

S Subset 

 

 


